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Abstract 
Climate change has greatly affected natural ecosystems, especially in sensitive 
mountainous regions such as Alps. The study focuses on monitoring water and 
vegetative resources in the Alpine region using satellite imagery, especially data 
from Sentinel -2 and Landsat 8. By analyzing multi-temporal and multispectral 
satellite data, hydrological patterns and changes are evaluated to understand the 
effects of climate change and long-term environmental trends. The main 
indicators such as snow cover extent, vegetative indices (e.g., NDVI), and surface 
water distribution are obtained from imagery to evaluate ecosystem reactions. 

 

 Conclusions reveal spatial and temporary changes in water availability and 
vegetation dynamics, providing valuable insight to permanent resource 
management and climate adaptation strategies in the hill environment. The effect 
of climate change on mountainous water resources is an important area of study, 
especially in areas such as small maritime, where glaciers and snow serve as 
significant freshwater sources. The purpose of this thesis is to monitor and 
analyze the effects of climate change on hydrological dynamics of Alpi Maritime 
using satellite imagery. While employing high -resolution data from satellites 
such as Landsat 8, Sentinel -2, we assess changes in snow cover, glacial extent 
and water bodies over the last three decades. Our functioning integrates remote 
sensing techniques with geographical information system (GIS) tools to do spatial 
and temporary analysis of hydrological variables. It is complemented by climate 
model and ground-based meteorological data that provides a wide understanding 
of views and patterns. The study identifies significant cuts in ice cover 

 

 

 

 

 

 

 

Keywords: Satellite imagery, Remote sensing, Climate change, Alps region, 
Water resources, Vegetation monitoring, Land cover change 
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1.Introduction 

Mountain ecosystems are often on the edge of their limits with respect to climate, 
and changes in temperature and precipitation patterns influence local hydrology 
in a dramatic fashion. A mountain range on the border between France and Italy1 
offers an example of such vulnerability — the Alpi Marittime. These mountains 
also host substantial glacial and snowpack stores, which serve as the main source 
of freshwater for ecosystems, agriculture, and human communities higher and 
lower in elevation. As through these water resources we are linked to the 
environment, understanding and following changes in these resources are also 
essential for developing successful adaptation and management options. 

Political and social responses to climate change also manifest in very clear and 
alarming ways in the Alpi Maritime. These changes are affecting the region’s 
water balance through reduced snow cover, glacial retreat, modifications to 
precipitation regimes and higher temperatures. These shifts have direct 
consequences for water resources, biodiversity and human livelihoods relying on 
these assets. Conventional ground-based monitoring techniques are rested in their 
breadth and scale, and hence the complete processes of this dynamics remain 
difficult to observe. 

 

Figure 1: Alpi maritime2 

In this context, satellite imagery emerges as a powerful tool for environmental 
monitoring. Remote sensing technologies provide high-resolution, continuous 

 
1 https://editions.covecollective.org/ 
2 Google images 
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and multi-temporal data that can cover large and inaccessible areas, providing a 
detailed photo of environmental changes over time. It is possible to monitor and 
analyze spatiotemporal variations in a snow cover, glacier extent and 
hydrological patterns by taking advantage of satellite data from sources like 
Landsat, Sentinel -1, and Sentinel -2. The purpose of this study is to use satellite 
imagination to monitor the effects of climate change on water resources of Alpi 
Marittime. Through a detailed analysis of satellite data and integration with 
climate models and ground-based comments, this tries to identify research trends, 
determine changes and assess wide assessments for the field hydroelectric. 
Conclusion will provide valuable insights into the range of climate-inspired 
hydrological changes and provide guidance to regional water resources 
management and conservation efforts. Understanding these dynamics is 
important not only for local and regional but also for national and global 
references.3 

 

Figure 2: Alpi maritime satellite view from Google Earth4 

Planning but also contributes to the global body of knowledge on climate Change 
the effects in mountainous regions. For example, this research stands at the 
intersection of environmental science, geography and resource management, 
which aims to highlight the complex interaction between mountain hydropower 
in climate change and ALPI Marittime. The Mountain range is the lifetime of 
many regions, which act as huge natural reservoirs that store and release 
freshwater throughout the year. One prominent example is Alpi Marittime, a 
mountain range with the border between France and Italy. These royal peaks feed 
important water resources for downstream communities, supporting agriculture,  

 
3 Rahman, S. (2023). EXAMINING THE RELATIONSHIP BETWEEN INTERNATIONAL INDICES AND 
INSTRUCTIONAL LEADERSHIP STYLES OF COLLEGE PRINCIPALS IN THE RURAL CONTEXT OF SINDH. 
Frontline Social Sciences and History Journal. https://doi.org/10.37547/social-fsshj-03-06-05 
4 Google Earth 
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Hydropower generations, and ecosystems. However, these precious stores hang 
a attractive threat: climate change. Rising global temperatures are changing 
weather patterns and mountains are affecting hydrology through important 
methods. Changes in rainfall patterns, first of the snowmelt, and glacial retreat 
are some of the trends. It is important to understand the limit and speed of these 
changes to ensure permanent water management in front of the changing climate. 
This study delays the application of satellite imagery as a powerful tool to monitor 
the impact of climate change on mountain water resources in Alpi Maritime.5 

By taking advantage of the unique capabilities of satellite technology, we can 
achieve valuable insight into important aspects of the hydrological cycle 
including snow Dynamics, Glassel Health, and Lake and River Behavior. 
Through a detailed analysis of multi-temporal satellite data, this research aims to 
determine spatiotemporal variations in water resources, identifying climate 
change trends, and eventually developing a comprehensive understanding of how 
these changes are affecting the availability of water in the minor maritime. The 
findings will not only contribute valuable knowledge to the region, but will also 
serve as a model to apply satellite-based monitoring strategies in other 
mountainous environments facing similar challenges. 

 

Figure 3: Alpi maritime sectors6 

 
5 (2014). Canadian Association of Cardiovascular Prevention and Rehabilitation (Association Canadienne 
de Prévention et de Réadaptation Cardiovasculaires) Annual Meeting and Scientific Abstracts. Journal of 
Cardiopulmonary Rehabilitation and Prevention. https://doi.org/10.1097/hcr.0000000000000081 
6 Google images  
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2.Motivation  
Climate change depth is changing the mountain ecosystem, in which the short 
marittime is highly unsafe for these effects. Increasing temperature and shifting 
rainfall patterns are changing ice cover and vegetation dynamics, which directly 
affect water resources, biodiversity and local communities. These changes end up 
both the availability of freshwater and the ecological balance of the region. To 
effectively monitor these changes, satellite remote sensing provides an essential 
tool. It enables observation of large and inaccessible areas over time, providing 
valuable data on long -term trends and seasonal variations. By analyzing satellite 
imagery, the purpose of this research is to assess the limit and implication of 
climate change on ice and vegetation in small maritime. Understanding these 
changes is important for permanent water resources management, ecosystem 
conservation and climate adaptation strategies. The purpose of this study is to 
bridge the gap between climate science and actionable environmental policies, 
ensuring that conclusions contribute to effective decisions and long -term 
conservation efforts in the hill environment. 

1. Satellite image of Alpi Maritime 

2. Over time the ice cover changes 

3. Effect of climate change on water resources 

4. Graph of temperature and rainfall trends 

 
Figure 4: Alpi maritime Google Earth view7 

 
7 Google Earth 
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With intensive implications for water resources, biodiversity and human 
activities, mountain ecosystems are the most sensitive to climate change. Alpi 
Maritime deployed in the convergence of the Mediterranean and Alpine Climate, 
is particularly unsafe for these changes. 

The rising temperature changed the pattern of rainfall, and changes in the mobility 
of the vegetation are re -shaping the hydrological balance of the area, affecting 
the ice cover and plant ecosystem. Given the important role of these elements in 
regulating water availability, their monitoring is necessary to understand 
environmental changes and reduce potential risks. 

Snow accumulation and vegetation dynamics directly affect water storage and 
release, which affects downstream communities, agriculture and hydroelectric 
power generation. However, traditional ground-based monitoring methods face 
challenges due to the huge spatial boundaries of rugged areas and mountainous 
regions. Satellite remote sensing offers a powerful option, which offers 
continuous, high-resolution comments that enabled to detect long-term trends in 
ice cover and vegetation change. 

This research satellite attempts to take advantage of imagery to analyze and 
determine the effects of climate change on the snow and vegetation of alternative 
maritime.8 

By integrating remote sensing data with climate and hydrological models, the 
purpose of this study is to improve our understanding of water resource variability 
in the hill environment. 

The insight obtained will not only enhance climate change adaptation strategies, 
but also supports policy makers, conservationists and water resources managers 
in developing a permanent approach to the protection of these delicate 
ecosystems. As global warming accelerates, accurate, data-powered monitor is 
required. 

 

 

 

 

 
8 Uyar, N. (2025). Spatiotemporal Dynamics of Carbon Storage in Utah: Insights from Remote Sensing and 
Climate Variables. Sustainability, 17(5), 1976. 
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3.Goals and Limits 
Target The primary purpose of this research is to use satellite imagery, focusing 
on the vegetation and ice cover in alternative maritime, assessing the effects of 
climate change and determining the effects of climate change on hill water 
resources. Specific goals include: 

1. Ice covered Analysis of seasonal and long -term changes in ice cover range, 
duration and melting patterns. o Assessing how the variation in snow 
accumulation and deficiency affects the availability of water. 

2. Collapse Evaluate changes in vegetation cover, species distribution and 
productivity using remote sensing indices (eg, NDVI, LAI). o Check the 
relationship between temperature changes, rainfall variability and vegetation 
growth. 

3. Understand climate-water conversation o changes in snow and vegetation 
with climate variables such as temperature and rain trends. o identifies 
important thresholds where climate changes greatly affect the availability of 
water and the stability of the ecosystem. 

4. Providing data for environmental management Water Resources 
Management, Biodiversity Protection and Climate provide insight for strategies. 
o Support the decision making and local communities with scientific evidence 
to guide the continuous environmental policies. This evaluation will be 
performed using satellite remote sensing data from Sentinel-2 and Landsat 
Landcover platforms, providing high-resolution and multi-temporal imagery 
suitable for monitoring environmental changes over time. 
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By taking advantage of satellite-based Earth Overview (EO) data, the purpose 
of this study is: 

 

1. Monitor changes in snow cover 

• Analysis of seasonal and differences in the limit of ice cover, firmness and 
melting patterns, to understand how climate change affects the accumulation 
and deficiency of ice. 

• Check ice phenology, including the onset of ice and melting-out time using 
satellite-type indices such as the generalized difference Snow index (NDSI). 

• Identify latitudinal shifts in ice cover and their implications for availability of 
water in downstream ecosystem. 

 

2. Assess vegetable reaction to climate change 

• Use botany indices such as the generalized difference vegetable index (NDVI) 
and the enhanced vegetative index (EVI) to evaluate trends in vegetative 
growth, productivity and seasonal variability. 

• Analyze vegetable greening and browning patterns, correlated them 

• With temperature and rainfall trends obtained from historical climate records. 

• To detect changes in land cover composition, expand alpine vegetation in high 
height due to especially rising temperature. 

 

3. Check climate-water interaction in mountain ecosystems 

• Check the relationship between the reduction in ice cover and the changes in 
vegetative productivity to determine the cascading effects of climate change on 
water availability. 

• Identify important thresholds where climate-induced variations in snow and 
vegetation affect hydrological cycles, ecosystems stability and biodiversity. 
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4. Provide actionable data for environment and water resources management 

• To support water resource management, conservation efforts and climate 
adaptation policies, generate spatial and temporarily solved maps of ice cover 
and vegetation trends. 

• Provide insight to local authorities, protectionists and policy makers to reduce 
the effects of climate change and develop permanent land management 
strategies. 

• Highlight areas that are the weakest for climate-inspired changes, helping 
long-term ecological monitoring and climate flexibility scheme. 

 

 

 

Figure 5: Region of Interest (ROI) in Copernicus website9 

 

 

 

 

 

 
9 https://browser.dataspace.copernicus.eu/ 
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Limits 

While this study provides valuable insight, it is subject to many limitations: 
Since Sentinel -2 began in 2015, the data is available from 2015 to 2023 
(Sentinel-2 was not present before 2015). 

Table 1: Satellites start and end time 

Sensor Start Date End Date / Status Notes 

Sentinel-2 2015-04-01 2023-08-31 Data available between these dates 

Landsat 5 1984 2013 Mission ended in 2013 

Landsat 7 1999 Present Still operational (as of 2025) 

Landsat 8 2013 Present Still operational (as of 2025) 

Landsat 9 2021 Present Still operational (as of 2025) 

 

 

Figure 6: One of our limits is when we want to search for a specific month 
satellite image, For example April 1991 there is no satellite image for our 
ROI(Region OF Interest) but for June 1991 and August 1991 we have satellite 
images as seen in this screenshot.10 

 
 

10 https://apps.sentinel-hub.com/eo-browser/ 
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1. Satellite data resolution obstacles 

Accuracy of monitoring vegetation and ice depends on the spatial and cosmic 
resolution of satellite imagery. Some small-scale changes may not be detected. 

Claude cover and atmospheric conditions can affect the quality and stability of 
satellite comments. 

 

2. Complexity of mountain ecosystems 

Interaction between climate, vegetation and ice cover is highly complex and 
affected by many factors (e.g., height, slope, soil structure and local weather 
patterns). 

Separating climate change effects from other anthropological effects (e.g., land 
usage changes, tourism) can be challenging. 

 

3. Data availability and temporary coverage 

Historical satellite data may have gaps or discrepancies, which can make long -
term trend analysis more difficult. 

Some satellite missions have limited operating lifespan, requiring data integration 
from many sources. 

 

4. Verification and Ground Truthing 

Remote sensing data often requires verification with field measurements, which 
may not always be possible in remote or rugged mountainous regions. 

Data processing methods and differential results in algorithm may introduce 
uncertainties. 

 

This study accepts many boundaries contained for the functioning used and data 
sources. 
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1. Satellite imagery resolution obstacles 

• The spatial resolution of Prahari-2 (10m-60m) and Landsat Landcover (~ 30 m), 
while enough for regional scale analysis, cannot occupy fine changes in ice cover 
and vegetation, especially in the asymmetrical mountainous terrain. 

• Some small -scale events, such as localized vegetation shifts or microclimatic 
effects, may be reduced due to pixel aggregation in satellite imagery. 

2. Atmospheric and environmental intervention 

• Cloud cover, shade and atmospheric conditions can affect satellite data quality 
and stability, especially in mountainous areas where frequent cloud covers can 
limit clear comments. 

• Seasonal snow cover detection may be affected by topographical 
cinematography in steep areas, causing potential miscarriage. 

3. Data availability and temporary coverage 

• While the Sentinel-2 (2015-current) and Landsat (1984-current) offer a valuable 
multi dataset, sensor technology and coverage borders are gaps in historical 
satellite records due to changes in boundaries. 

• Differences in data acquisition frequencies between observers -2 (every 5 days) 
and Landsat (~ 16 days) can create challenges in ensuring frequent temporary 
coverage for long -term trend analysis. 

 

Figure 7: Timeline of the Landsat program, starting with the launch of Landsat 
1. Landsat 9, launched September 27, 2021, will continue the legacy of the 
Landsat program.11 

 
11 https://www.copernicus.eu/ 
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4. Mountain ecosystem 

• The response to vegetation and ice cover to climate change is affected by 
several interaction factors, including topography, local microclimates and 
anthropogenic activities (e.g., land-use changes, tourism development). 

• To separate the direct effects of climate change from other environmental 
drivers, requires careful interpretation and cross-satisfaction with auxiliary data 
sources (e.g., meteorological data, ground comments). 

 

5. Verification challenges 

• Remote sensing data analysis depends on algorithm-based classification 
methods, which can introduce errors in detection of land cover classification 
and change. 

• Ground truth verification is necessary to improve the accuracy of satellite-
satellite projections, but may be challenging in remote or inaccessible areas of 
Alpi Maritime. 

 

Landsat data can be found on the following sources: 

1-USG Earth Explorer12  

 

• A USGS account should be created before accessing data. 

• Search bar is used to detect the area of interest. 

• Landsat Mission (e.g., Landsat 8, Landsat 9) is selected from dataset options. 

• Cloud cover filter is applied to exclude cloud images. 

• Level -2 surface reflection data is recommended for better atmospheric 
improvement. 

• Selected dataset has been downloaded. 

 

 
12 https://earthexplorer.usgs.gov/ 
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2- NASA Earthdata13 
 

• Landsat data is accessed through this platform. 

• An earthdata login is required before downloading. 

 

3- Google Earth Engine 14 
 

• Landsat archives are available for cloud-based analysis. 

• JavaScript or Python coding should be used to process data. 

Since the Sentinel -2 images can be downloaded from the Copernicus Open 
Access Hub 

 
Figure 8: Sentinel reference products15 

 

13 https://search.earthdata.nasa.gov/ 

14 https://developers.google.com/earth-engine/datasets/catalog/landsat 
15 https://www.copernicus.eu/ 

https://search.earthdata.nasa.gov/
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Landsat vs. Sentinel:  

Landsat and Sentinel are two major Earth observation satellite programs used 
for remote sensing. The free satellite imagery is provided by both, but the 
differences can be seen in the context of the objectives of the mission, spatial 
resolution, temporary coverage and spectral band. 

Landsat: 

Landsat Earth observation is a series of satellites run since 1972 by NASA and 
USGS (United States Geological Survey). The program has been monitored on 
the surface of the Earth for 50 years, making it the longest remote sensing 
initiative. 

Major features of Landsat: 

• Latest Edition: Landsat 8 (2013), Landsat 9 (2021) 

• Local resolution: 30 m (multispectral), 15 m (Panchromatic), 100 meters 
(thermal) 

• Revision time: every 16 days 

• Spectral Band: 11 (Landsat 8 and 9), which covers the visible, close-
concentrated (NIR), short way-rolling (SWIR), and thermal infrared (TIR) 
sector 

• Main Application: Land Use Monitoring, Deforestation, Water Resources, 
Climate Change and Disaster Response are supported by this satellite chain 
Guarded 

 

Figure 9: Landsat 8 Satellite16 Sensor (15m)17 

 
16 Google images 
17 https://www.satimagingcorp.com/satellite-sensors/other-satellite-sensors/landsat-8/ 
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Sentinel -2: 

The Sentinel is part of the Copernicus program, which is managed to provide 
free Earth observation data by the European Space Agency (ESA). Sentinel -2 is 
considered the main contestant of Landsat for optical imagery. 

• Latest Edition: Sentinel -2A (2015), Sentinel -2B (2017) 

• Local resolution: 10 m (RGB and NIR), 20 meters (SWIR), 60 meters (coastal 
and water vapor) 

• Revision time: Every 5 days (with two satellites) 

• Spectral Band: 13 (More than Landsat, including red edge for vegetation 
monitoring) 

• Main Application: Agriculture, Botanical Health, Land Cover Classification, 
and Water Quality Monitoring is supported 

 

Figure 10: Sentinel-2 18satellite19 

Table 2: Key Differences Between Landsat & Sentinel-2 

Feature Landsat 8/9 Sentinel-2A/B 

Organization Is operated by NASA / 
USGS Is managed by ESA / Copernicus 

Launch Years 2013 (L8), 2021 (L9) 2015 (S2A), 2017 (S2B) 

Revisit Time Is set at 16 days per 
satellite Is shortened to 5 days (with two satellites) 

Spatial 
Resolution 

30m (MS), 15m 
(Panchromatic) 

Is improved to 10m (RGB & NIR), 20m 
(SWIR), 60m (other bands) 

Spectral Bands Are limited to 11 Are expanded to 13 (including Red Edge 
bands) 

Thermal 
Infrared 

Yes (TIR bands are 
included) No TIR bands are provided in Sentinel-2 

 
18 https://www.earthdata.nasa.gov/data/instruments/sentinel-2-msi 
19 Google images 
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Landsat must be selected: 

• Historical data is required (back by 1972) 

• Thermal imaging is required (for studies related to land surface temperature) 

• A 30 meter resolution is considered acceptable 

 

Sentinel -2 should be used: 

• A high resolution (10 m) is preferred for vegetation and land use analysis 

• More frequent imagination (every 5 days) requires 

• Vegetation health should be analyzed using red edge bands 

 

The Sentinel -2 is recommended for modern applications such as its high 
resolution and frequent revision capacity, while Landsat is preferred when long 
-term historical analysis and thermal imaging are required. 

 

The phrase "cloud mask for vague images" is referred to as a procedure that 
applies in remote sensing and satellite imagery to ensure that areas covered by 
clouds are filtered with images. 

 

Breaking meaning: 

• Cloud Mask → A technique that is applied to the cloud detection and mask 
(hiding or ignoring) in satellite images. 

• unclear images → images that are unclear by cloud cover. 

 

Clouds are often present in satellite images, blocking the surface of the Earth 
from the view. Cloud masking is used: 

• Cloud -covered pixel can be removed 

• Image clarity for analysis can be improved 

• Land cover classification and vegetation monitoring can be increased 
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Cloud masks are usually generated using: 

• Thresholding technology, where glitter and temperature are used as the basis 
for detection 

• Machine learning models, which are trained to identify clouds 

 

• Pre -existing cloud detection algorithms, such as SCL bands of Sentinel -2 and 
Masks of Landsat, which are used for the purpose of cloud masking 

 

The difference between Tiff 8-bit, 16-bit and 32-bit is primarily defined by bit 
depth, determining how color or information per channel is stored. The 
comparison of these formats is as follows: 

 

Tiff 8-bit 

• 8 bits data are allocated to each color channel (red, green, blue), resulting in 
256 potential values per channel. 

 

• This format is usually used for standard images (as seen in JPEG and PNG). 

 

• A total of 16.7 million colors (256 × 256 × 256) are supported. 

 

• It is considered suitable for web images and printing, but is considered limited 
to professional photo editing due to low color depth. 
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Tiff 16-bit 

• 16 bits are assigned to each channel, which enable 65,536 potential values per 
channel. 

• The colors of trillions are supported, allowing smooth gradients and enhanced 
color accuracy. 

• This format is widely used in professional photography, medical imaging and 
high-end printing. 

• A larger file size is produced compared to 8-bit, but is preferred for more 
detailed editing. 

 

 

Tiff 32-bit 

• 32 bits are given to each channel, which allows more than 4.29 billion per 
potential values per channel. 

 

• This format applies in HDR (high dynamic range) imaging and scientific 
research. 

 

• Excessive precision is supported in glitter and color data. 

 

• Files of large size are generated, and this format is usually not necessary for 
standard photography. 
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4.Case Study 

The case study focuses on the Alpi Marittime time, a mountain range on the 
border between France and Italy. This specific region provides a practical and 
significant example for the application of satellite imagery in monitoring the 
impacts of climate change on mountain water resources. The choice of the Alpi 
Marittime as a case study is driven by several key factors: 

 

Figure 11: Case study area in QGIS software 

 

 

1. Mountain Water Tower: 

o Alpi Maritime acts as an important water tower, storing winter snowfall and 
glaciers that release freshwater throughout the year. This water is necessary to 
maintain the regional ecosystem, support agriculture and provide water for 
human consumption. 

2. Climate change vulnerability: 

o Area is highly unsafe for the effects of climate change. Changes in 
temperature and rainfall patterns are leading to glacial retreat, low ice cover and 
earlier snowmelt. These changes greatly affect the availability and distribution 
of water resources. 
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3. Satellite data access: 

o Alpi Maritime is well covered by various satellite missions, which provide 
broad and detailed datasets. High -resolution imagery from satellites such as 
Landsat, Sentinel -1 and Sentinel-2 enables widespread monitoring and analysis 
of environmental changes over time. 

2.1 Justification for choosing a small maritime 

• Importance: The role of small marittime as a major water source is an 
important area to study the effects of climate change on water resources. 

• Data Availability: Availability of high-resolution satellite data for this sector 
allows for detailed and accurate monitoring of ice covers, glacier limits and 
changes in hydrological patterns. 

• Representative Examples: The characteristics of Alpi Marittime make it 
representative of other mountainous regions that are facing uniform climate 
change challenges. This study can apply conclusions and functioning in other 
areas globally. 

2.2 Case Study Objectives 

• Assess changes in ice and glacial cover: Analyze satellite imagery to monitor 
the range and quantity of glaciers and ice cover over time. 

• Evaluate hydrological changes: check changes 

 

The land cover classification is defined as the process in which the Earth's 
surface is classified into different types (eg, water, forest, urban, agriculture), 
based on satellite imagery or air photos. It is used for environmental monitoring, 
urban planning and resource management. 

Two main types of classifications are recognized: 

• Supervised classification - Training samples for known land cover types are 
manually selected, and the rest of the image is classified by software. 

We use supervised classification in Arc GIS Pro. 

 

• Uncontrolled classification - Pixel is automatically classified into a cluster by 
software based on spectral equality, and the results are interpreted later. 
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5.Data 

Most of the data are from guards -2 and Landsat 8 satellites 

1. Satellite data (primary data source) 

Since this study focuses on remote sensing, the main dataset will come from 
Sentinel -2 and Landsat landcover platforms. 

 

Table 3: Satellite Data information 

Satellite Platform Key Data Products Purpose 

Sentinel-2 (ESA) 

- Multispectral images (10m–60m 
resolution) - NDVI, EVI, and NDSI 
indices - Snow and vegetation cover 
analysis 

- High-resolution vegetation 
monitoring - Snow cover 
detection and change analysis 

Landsat Landcover 
(NASA/USGS) 

- 30m resolution multispectral images - 
NDVI, NDSI, and other vegetation 
indices - Long-term land cover change 
data 

- Historical comparison of 
snow and vegetation trends 
since the 1980s 

 

 
Figure 12: Case study area in EO Browser20 

 
20 https://apps.sentinel-hub.com/eo-browser/ 
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2. Climate Data 

To correlate vegetation and snow changes with climate trends, meteorological 
data will be need: 

Table 4: Climate Data information 

Data Type Source Purpose 

Temperature (min/max) 
- ERA5 (Copernicus Climate 
Data) - Local meteorological 
stations 

- Understanding warming trends 
and their effect on snow and 
vegetation 

Precipitation (Rain & 
Snowfall) 

- ERA5, CHIRPS, or local 
weather stations 

- Evaluating changes in snowfall 
and rainfall patterns 

Snow Depth & Snow 
Water Equivalent (SWE) 

- Sentinel-1 (SAR data) - In-situ 
measurements (if available) 

- Estimating snow accumulation 
and melt dynamics 

 

 

3. Land Cover and Topography Data 

These datasets will help in classifying and understanding the landscape: 

 

Table 5: Land Cover and Topography Data information 

Data Type Source Purpose 

Land Cover 
Classification 

- ESA World Cover - CORINE Land 
Cover (Europe) - Landsat-derived land 
use maps 

- Identifying vegetation types and 
their changes 

Digital Elevation 
Model (DEM) 

- Copernicus DEM - NASA SRTM (30m 
resolution) 

- Understanding terrain influence on 
snow distribution and vegetation 
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4. Ancillary Data (Validation & Supplementary Information) 

 

 

To improve accuracy and validate satellite results, additional ground-based and 
auxiliary data can be useful: 

 

 

 

Table 6: Land Cover and Topography Data information 

Data Type Source Purpose 

Ground Truth Data (Field 
Observations) 

- Local ecological surveys (if available) - 
Snow and vegetation sampling 

- Validating remote sensing 
classifications 

Historical Aerial Images - Local environmental agencies - Google 
Earth historical images 

- Visual comparison with 
modern satellite images 

Glacier & Hydrology Data - GLIMS Glacier Database - Local 
hydrological models 

- Assessing water resource 
changes 
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Summary of Required Data 

I. Satellite Data: Sentinel-2 & Landsat (for snow and vegetation monitoring) 
II. Climate Data: Temperature, precipitation, and snow cover trends 
III. Land Cover & Terrain Data: DEMs and land use classifications 
IV. Validation & Ancillary Data: Field observations, historical aerial imagery, 
and glacier/hydrology 

 

 

 

Figure 13: Choose April, June, August in EO Browser for collecting data21 

 

 

Figure 14: Choose L2A for Sentinel2 satellite in EO Browser22 

 

 

 
21 https://apps.sentinel-hub.com/eo-browser/ 
22 https://apps.sentinel-hub.com/eo-browser/ 
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If clouds are still present in some images, Sentinel-2 Cloud Masking (SCL 
band) should be used in Custom Scripts to have the clouds removed from the 
image. 

 

Figure 15: After selecting several satellite photos shows in EO Browser23 

 

 

Figure 16: In visualize section shows some indexes24 

 
23 https://apps.sentinel-hub.com/eo-browser/ 
24 https://apps.sentinel-hub.com/eo-browser/ 
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Figure 17: Corine land cover classes that we need for classification 25 

 
25 https://www.eea.europa.eu/data-and-maps/figures/corine-land-cover-1990-by-country/legend 
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6.Methods and Methodology 
State of the art 
Landcovers 

Mountain ecosystems are particularly sensitive to climate change, affecting ice 
cover and vegetation dynamics with rising temperature and changing rainfall 
patterns. These changes, in turn, affect water availability, biodiversity and 
ecological stability. Located at the intersection of the Mediterranean and Alpine 
Climate, there is an ecological region where the effects of climate change are 
becoming increasingly clear. 

Remote sensing has emerged as a powerful tool for monitoring these 
environmental changes over time, which provides spatial data on the boundary of 
ice cover, vegetation dynamics and land cover variations. Satellite platforms such 
as Sentinel -2 and Landsat landcover provide valuable insight into the 
development of mountain ecosystems in response to climate change. 

 

6.1. Climate change and its effect on mountain water resources 

6.1.1 snow cover change 

Snow mountain is an important component of hydrology, which acts as a natural 
reservoir that controls the availability of water for the Downstream Ecosystem. 
Causes of climate change: 

• The duration of ice cover and the decline in the earlier ice period. 

• Latitudinal shifts, where the snow line is increasing, is reducing seasonal snow 
accumulation at low height. 

• Increase in variability in snowfall, with high rainfall in the form of rain instead 
of snow. 

Studies using the Generalized Difference Snow Index (NDSI) from the Sentinel 
-2 and Landsat have demonstrated that the ice cover in Alpine regions has been 
decreasing in the last decades, affecting water storage and river discharge 
patterns. 
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6.1.2 Botanical reaction to climate change 

Rising temperatures and converted rainfall pattern have led: 

• Vegetation greenery at high altitude, as plant species migrate to areas that were 
earlier covered with snow. 

• Changes in phenology (seasonal growth cycle) with first plant growth and 
expanded growing seasons. 

• Decreased vegetation productivity in some areas due to increasing drought 
stress. 

By analyzing botanical indices such as the Generalized Difference Botanical 
Index (NDVI) and the Enhanced Botanical Index (EVI), researchers can detect 
trends in botanical health, biomass and distribution changes in response to climate 
change. 

 

 

6.2. Role of satellite remote sensing under climate change supervision 

Remote sensing provides a cost -effective and scalable approach to study long -
term environmental changes. The Sentinel -2 (European Space Agency) and 
Landsat (NASA/USGS) are one of the most widely used platforms for monitoring 
the ecosystems of the mission. 

Table 7: Role of Satellite Remote Sensing in Climate Change Monitoring 
information 

Satellite Platform Resolution Relevant Indices Application 

Sentinel-2 10m–60m NDVI, EVI, NDSI Vegetation & snow cover monitoring 

Landsat Landcover ~30m NDVI, NDSI Long-term land cover change analysis 

 

Using these satellite datasets, researchers can track multi-temporal changes in 
snow and vegetative cover, supporting climate change assessment and adaptation 
strategies. 
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• 6.3. Land cover in climate change studies and its importance 
• Land cover classification is necessary to understand how various 

ecosystems react to climate change. The land cover mapping provides 
insight into the spatial distribution of forests, grasslands, glaciers and bare 
ground, it helps to assess how these areas are changing over time. 

 

• 6.3.1 Land Cover Type in LPI Maritime 
• 1. Remote sensing and satellite imagery: Use satellite sensors and 

platforms to capture data for high-resolution images and ice cover for 
maping, glacier retreat and data for vegetation. 

• 2. Data integration and analysis: Mix the satellite data with climate models, 
ground-based meteorological data and hydrological models for 
comprehensive analysis. 

• 3. Spatial and temporary analysis: Use geographical information system 
(GIS) equipment to analyze local patterns and temporary changes in water 
resources. 

• By focusing on ALPI marittime, this case study demonstrates the 
effectiveness of satellite image analysis under the supervision of climate 
change effects on mountain water resources. The insight obtained can 
inform the adaptive water management strategies and contribute to the 
widespread understanding of climatic effects on hilly areas worldwide. 

•  
• There are diverse land cover types in the short maritime area, including: 
• • Forest: Alpine coniferous forest, deciduous woodlands. 
• • grasslands and shrubs: high altitude grasslands, subalpine shrubs. 
• • Glacier and snowfields: permanent and seasonal snow -covered areas. 
• • Bare rock and soil: mountain rock, erosion-prone area. 

 

• 6.3.2 Climate-inspired land cover change 
• Land cover changes in response to climate variations include: 
• • Reducing glaciers and snowflants, reducing water storage capacity. 
• • Due to long time, forest expansion in high height Increased bare Land 

 and erosion, as snowmelt exposes the already covered surfaces. 

• By integrating the Sentinel -2 and Landsat landcover data, land cover 
changes can be detected, classified, and can be correlated with climate 
trends to predict future environmental changes. 
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Methodology: Acquisition, Preprocessing, Classification, 
and Analysis of Landsat Satellite Imagery 

• This section underscores the functioning for achieving Landsat Satellite 
and Sentinel 2 imagery, preprocessing, classification and analysis. 
Including the months of April, June and August, the focus will be on 
obtaining open-source data from 1991 to present. Processed data will then 
be used for land cover classification and subsequent analysis in Geography 
Information System (GIS) software (QGIS) and Remote Sensing Image 
Analysis Software (ENVI). And then use (Arc GIS Pro). 

 

• 1. Applied application 
• • Satellite image is loaded into QGIS. 
• • Raster Calculator (Raster → Raster Calculator) is used to apply the index 

formula. Common sources include: 

 

I - NDVI (Normalized Difference Vegetation Index): 

 

 

 

 

 

II - NDWI (Normalized Difference Water Index): 

 

 
 



36 
 

III-Normalized Difference Snow Index (NDSI) 

 

 
 
The Semi-Automatic Classification Plugin (SCP) is used if predefined index 
calculations are required.  
The resulting index layer is visualized and analyzed. 

 
2. Classification with Land Cover and Accuracy Assessment 

• The SCP Plugin is used for classification. 
• Training samples are selected based on the land cover map. 
• A classification algorithm (such as Random Forest, Maximum 

Likelihood, or SVM) is chosen. 
• The classification process is executed, and a classified image is 

generated. 

Accuracy Assessment 

• The classified map is compared with the land cover map of the same year. 
• An Error Matrix (Confusion Matrix) is generated. 
• Overall Accuracy, Producer’s Accuracy, and User’s Accuracy are 

calculated. 

 

 
Preprocessing Steps 

1. Data Preparation 

• Satellite images from April, June, and August (1991–2023) are 
collected. 

• The images are clipped to the Region of Interest (ROI). 
• A cloud mask is applied to remove unclear areas. 
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2. Index Calculation 

Two vegetation indexes: 

1. NDVI (Normalized Difference Vegetation Index) 

 

 
 

2. SAVI (Soil-Adjusted Vegetation Index)     

    

 

 

 (L is a soil brightness correction factor, typically 0.5) 

 

 

 

 

Two snow indexes: 

1. NDSI (Normalized Difference Snow Index)  
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2. NSDI (Normalized Snow Difference Index)  

 

 

Two water indexes: 

1. NDWI (Normalized Difference Water Index)    

 

 

2. MNDWI (Modified Normalized Difference Water Index)  

 

 

 

 

All indexes are computed using the Raster Calculator in QGIS. 

 

Classification Process 

1. Land Cover Classification (Level 1 Only) 

• Land cover classes: Vegetation, Water, Snow. 
• 2018 snow is excluded from the classification. 
• The Supervised Classification Plugin (SCP) is used. 
• Training samples are selected for Vegetation, Water, and Snow based 

on reference land cover maps. 
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2. Second step for classification  

• Input classification is prepared. 

• Various overall bands are tested. 

• All bands are merged into a single overall band before classification. 

• Each pixel is classified on the basis of spectral properties. 

 

 

Figure 18: Satellite image of sentinel 2 for 2020/04/14 after classification – 
Screenshot from Arc GIS Pro software 
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Accuracy assessment 

Confusion matrix extraction and index test 

First attempt: 

• All bands are used only for classification. 

• An illusion matrix is produced. 

 

Second attempt: 

• All bands + some index (e.g., NDVI, NDWI) are used. 

• Classification accuracy is compared with the first attempt. 

Third attempt: 

• All bands + all index are used. 

• Final classification results are analyzed. 

 
Figure 19: Confusion matrix table after doing the accuracy assessment – 

screenshot from Arc GIS Pro software 
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STEP 1: Data Preparation 

1. Satellite Images Loading 
o The images from April, June, and August (1991–2023) are 

loaded into QGIS. 
o The Add Raster Layer tool is used to import the images. 

2. Clipping to Region of Interest (ROI) 
o The Clip Raster by Mask Layer tool is selected from the 

Processing Toolbox. 
o The satellite image is clipped using the ROI shapefile. 

3. Cloud Masking 
o A cloud mask is applied to remove unclear areas. 
o If Sentinel-2 images are used, the QA60 Band is selected for 

cloud removal. 
o If Landsat images are used, the Quality Assessment (QA) Band 

is applied. 
o Alternatively, cloud masking is performed using the Semi-

Automatic Classification Plugin (SCP). 

 
 
 
STEP 2: Spectral Index Computation 

The Raster Calculator (Raster → Raster Calculator) is used to compute the 
following indexes: 

1. Vegetation Indexes 

• NDVI (Normalized Difference Vegetation Index) is calculated using 
the formula:  

(NIR - Red) / (NIR + Red) 

• SAVI (Soil-Adjusted Vegetation Index) is computed as:  

((NIR - Red) / (NIR + Red + 0.5)) * (1.5) 
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2. Snow Indexes 

• NDSI (Normalized Difference Snow Index) is generated using:  

(Green - SWIR1) / (Green + SWIR1) 

• NSDI (Normalized Snow Difference Index) is calculated as:  

(NIR - SWIR1) / (NIR + SWIR1) 
3. Water Indexes 

• NDWI (Normalized Difference Water Index) is derived using: 

(Green - NIR) / (Green + NIR) 

• MNDWI (Modified NDWI) is applied with: 

(Green - SWIR1) / (Green + SWIR1) 

• Each index is saved as a new raster layer 

 
STEP 3: Merging Bands into a Composite Image 
 

1. The Merge Rasters tool is opened from the Processing Toolbox. 
2. All individual bands and indexes are selected for merging. 
3. The output composite image is saved for classification. 
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STEP 4: Supervised Classification 
(Only Level 1: Vegetation, Water, Snow) 

1. The Semi-Automatic Classification Plugin (SCP) is installed and 
opened 

o The Plugins menu is accessed → Manage and Install Plugins → 
SCP is installed. 

2. Training Samples Selection 
o The 2018 Land Cover Map is used as a reference (excluding 

snow). 
o The ROI tool in SCP is applied to select training samples for 

Vegetation, Water, and Snow. 
3. Supervised Classification Execution 

o The SCP Classification tool is accessed from the Processing 
Toolbox. 

o The merged raster is selected as input. 
o A classification algorithm (Random Forest, Maximum 

Likelihood, or SVM) is chosen. 
o The classification process is executed. 

 
 
 
STEP 5: Classification for Water 

1. Preparation of Input Classification 
o The classified land cover output is used as input for water 

classification. 
2. Use of Different Band Combinations 

o Various composite band inputs are tested (e.g., RGB, NIR-SWIR-
Green). 

3. Merging of All Bands into a Composite Image 
o The Merge Rasters tool is used again to combine all bands into 

one. 
4. Classification of Water Pixels 

o The SCP Classification tool is executed again, focusing on the 
Water category. 
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STEP 6: Accuracy Assessment (Confusion Matrix & 
Index Comparison) 

1. Extraction of the Confusion Matrix 
o The Confusion Matrix tool is located in the Processing Toolbox. 
o A reference dataset (ground truth points or land cover map) is 

used. 
o The matrix is generated and saved. 

2. Three Classification Attempts 
o First Attempt: Classification is performed using all bands only. 
o Second Attempt: Classification is repeated using all bands + 

selected indexes (e.g., NDVI, NDWI, NDSI). 
o Third Attempt: Classification is executed using all bands + all 

indexes. 
3. Comparison of Results 

o The accuracy of each classification attempt is assessed. 
o The best classification result is saved for final analysis. 

 
 
 
 
 
 
 
Final Output: 

• A Classified Land Cover Map with three categories: Vegetation, 
Water, and Snow. 

• Confusion Matrix and Accuracy Report. 
• A comparison of different classification attempts for accuracy validation. 
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6.4. Data Acquisition 

Satellite imagery for Sentinel-2 and Landsat 8 is acquired from EO Browser, an 
online platform provided by the European Space Agency and Sinergise. To begin 
the process, the EO Browser website is accessed through a web browser. A user 
account is typically created or signed into, although public access is permitted for 
basic functionality. 

Once the platform is accessed, the area of interest (AOI) is located by navigating 
the interactive map or by entering coordinates or place names. The search panel 
is then used to specify the desired satellite (Sentinel-2 or Landsat 8), the date 
range, and additional filtering options such as cloud cover percentage. 

After the search parameters have been defined, available scenes are displayed. 
Relevant images are previewed to assess cloud cover and scene quality. Once a 
suitable image has been identified, the Analytical download option is selected to 
ensure that bands in original resolution are obtained. For Sentinel-2, Level-2A 
surface reflectance products are typically chosen. For Landsat 8, Level-2 Surface 
Reflectance data is selected to ensure that atmospheric correction has already 
been applied. 

The selected image is then downloaded as a .zip archive containing individual 
spectral bands and metadata. After the download is completed, the compressed 
folder is extracted, and the spectral bands are reviewed. Only the necessary bands 
for classification are retained. These bands are then imported into ArcGIS Pro for 
further processing and analysis. 

Throughout the process, attention is paid to spatial resolution, cloud cover, and 
acquisition date to ensure that only high-quality data is acquired. Metadata files 
are retained for documentation purposes and may be used during preprocessing 
or accuracy assessment. 

 

o Date Range: Set the date range from 1991-01-01 to end of 2022, 
ensuring capture of data for the desired months (April, June, August) 
across the entire timeframe. 

o Cloud Cover: Implement a cloud cover threshold (e.g., less than 
10%) to minimize the impact of clouds on image quality and 
subsequent analysis. 

• Download Format: Select a download format compatible with both QGIS 
and ENVI. Options might include GeoTIFF or HDF-EOS. 
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6.5. Preprocessing 
To begin the classification process in ArcGIS Pro, satellite data must first be 
downloaded and properly prepared. Sentinel-2 data should be obtained from the 
Copernicus Open Access Hub or other suitable platforms, and Landsat 8 data 
should be retrieved from the USGS Earth Explorer or similar sources. For both 
sensors, Level-2 surface reflectance products are recommended, as they are 
atmospherically corrected. 

 

Once the data has been downloaded, it must be imported into an ArcGIS Pro 
project. Individual spectral bands are typically provided in .jp2 or .tif format 
and must be added to the map. After being added, the relevant bands should be 
combined into a single multiband raster using the “Composite Bands” tool. This 
tool is accessed through the Geoprocessing toolbox, and appropriate bands are 
selected based on the study objective. 

 

After the composite image has been created, it must be clipped to the area of 
interest. This is done using the “Extract by Mask” tool, where the composite 
raster is masked using a shapefile or feature layer that defines the desired study 
area. The output raster will then be limited to this spatial extent. 

 

The coordinate system of the data should be checked to ensure consistency. If 
discrepancies are found between the imagery and the AOI shapefile, a 
projection transformation should be applied using the “Project Raster” tool so 
that all layers are spatially aligned. 

At this stage, optional image enhancement techniques can be applied to improve 
the visual quality or classification accuracy. Methods such as contrast 
stretching, histogram equalization, or principal component analysis may be 
used. In some cases, false-color composites can be created by adjusting the band 
combinations, which is particularly useful for highlighting specific features such 
as vegetation or water bodies. 

 

After all processing steps have been completed, the project should be saved. 
Layers should be renamed clearly, and the workspace should be organized to 
ensure that the analysis can be documented and repeated if necessary. 
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6.6. Classification 

Supervised Classification 

One of the classification algorithms is run using the training samples. 

a. Classification Tool 

The “Train Support Vector Machine Classifier”, “Train Random Trees 
Classifier”, or “Train Maximum Likelihood Classifier” tools are used. 

 

b. Classification Execution 

The “Classify Raster” tool is run using the trained model to produce a land cover 
classification map. 

Post-classification Processing 

a. Filtering 

The Majority Filter or Boundary Clean is applied to reduce noise and enhance 
spatial coherence. 

b. Reclassification 

The “Reclassify” tool is used to group land cover classes or simplify the 
classification output. 

Accuracy Assessment 

The “Create Accuracy Assessment Points” and “Compute Confusion Matrix” 
tools are used. 

The classification is compared with ground truth or reference data. 

Accuracy is evaluated using metrics such as Overall Accuracy, Producer’s 
Accuracy, User’s Accuracy, and the Kappa Coefficient. 
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6.7. Analysis 

After the necessary satellite imagery has been acquired and preprocessed, the data 
is analyzed within the ArcGIS Pro environment. First, spectral bands are 
examined, and appropriate combinations are applied to create meaningful 
visualizations. Natural and false-color composites are generated to highlight 
specific features such as vegetation, water bodies, or built-up areas. 

To initiate land cover analysis, training samples are created. These samples are 
drawn from known land cover types and are assigned class labels. They are 
generated by digitizing polygons or points within the image, using the “Training 
Samples Manager” tool. Once the training dataset has been finalized, a supervised 
classification algorithm is selected. 

The classification model is trained using the selected samples. Tools such as 
“Train Support Vector Machine Classifier,” “Train Random Trees Classifier,” or 
“Train Maximum Likelihood Classifier” are used. The trained model is then 
applied to the composite image using the “Classify Raster” tool, and a classified 
map is produced. 

Post-classification procedures are carried out to refine the results. Noise is 
reduced using spatial filters such as Majority Filter, and class boundaries are 
cleaned for better visual clarity. If necessary, class values are reclassified to 
simplify the output or combine similar categories. 

To validate the accuracy of the classification, assessment points are generated and 
compared with reference data. A confusion matrix is created, and accuracy 
metrics such as Overall Accuracy, User’s Accuracy, Producer’s Accuracy, and 
the Kappa Coefficient are calculated. These metrics are used to evaluate the 
performance of the classification process. 

Finally, the results are exported and documented. The classified raster is saved, 
and thematic maps are prepared for presentation or reporting. Through this 
process, meaningful land cover information is extracted from the satellite 
imagery, and spatial patterns are analyzed for further interpretation. 
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6.8. Integration and Interpretation 

After classification and accuracy assessment have been completed, the results are 
integrated with other spatial datasets to support further interpretation. Classified 
raster outputs are added to existing GIS layers, and land cover information is 
compared with administrative boundaries, infrastructure layers, and 
environmental features. This allows spatial relationships to be explored and 
understood in a broader geographic context. 

Additional vector and raster datasets are incorporated into the project to enrich 
the analysis. Elevation data, road networks, water bodies, and land use plans are 
overlaid with the classified imagery. Through this integration, patterns of land 
use, vegetation distribution, or urban expansion are identified. These insights are 
then used to inform planning, management, or decision-making processes. 

Thematic maps are created to visualize the results effectively. Legends, labels, 
scale bars, and north arrows are added using the view in ArcGIS Pro. These maps 
are then exported or printed to be shared with stakeholders, researchers, or policy 
makers. Summary statistics are generated, and spatial patterns are described in 
reports or presentations. 

Interpretation is guided by both visual observation and quantitative analysis. 
Areas of change are detected by comparing classified images from different dates, 
and land cover transitions are examined. Findings are contextualized within local 
environmental, social, or economic conditions, and conclusions are drawn based 
on the observed data. 

Finally, all results are documented, and metadata is updated to reflect the 
processing steps and analytical methods that have been applied. The analysis is 
thus made reproducible, and the outputs are prepared for long-term storage or 
future reference. 
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Additional Considerations: 

When remote sensing data is analyzed in ArcGIS Pro, several additional 
considerations must be taken into account to ensure the reliability and 
applicability of the results. First, attention must be given to the temporal 
resolution of the data. The acquisition dates of Sentinel-2 and Landsat 8 imagery 
should be carefully selected to correspond with the seasonal or phenological stage 
of interest. If multi-temporal analysis is intended, images must be acquired under 
similar atmospheric and lighting conditions to minimize inconsistencies. 

Cloud cover must also be considered. Scenes with high cloud or haze coverage 
should be avoided, or cloud-masked products should be used. In some cases, 
cloud and shadow masks are provided with the imagery and should be applied 
before analysis to ensure accurate classification results. 

The spatial resolution of the data must be matched with the scale of the analysis. 
Sentinel-2 imagery offers higher spatial resolution for key bands and may be 
preferred for detailed studies, while Landsat 8 is suitable for broader regional 
assessments. When both datasets are used, care must be taken to resample or align 
them appropriately. 

Spectral characteristics of land cover classes must be understood before 
classification is performed. If spectral confusion between classes is expected, 
additional indices such as NDVI, NDWI, or built-up indices may be derived and 
included in the analysis to improve class separability. 

Moreover, classification accuracy may be influenced by the quality of training 
samples. To ensure reliable results, representative and well-distributed samples 
must be collected across the study area. If sufficient ground truth data cannot be 
obtained, validation may be limited, and results must be interpreted with caution. 

Finally, hardware and software performance should be considered. High-
resolution data and large geographic extents may require substantial computing 
power. Processing times can be reduced, and stability can be improved by 
optimizing raster settings and organizing the workspace efficiently. 

By addressing these factors during the planning and execution of the analysis, 
more accurate, meaningful, and reproducible outcomes can be achieved. 
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Vegetation Indexes (VI) 

• NDVI (Normalized Difference Vegetation Index) 
o Formula: (B8 - B4) / (B8 + B4) 
o Required bands: B8 (NIR) & B4 (Red) 

• EVI (Enhanced Vegetation Index) 
o Formula: 2.5 × (B8 - B4) / (B8 + 6B4 - 7.5B2 + 1) 
o Required bands: B8 (NIR), B4 (Red), B2 (Blue) 

Water Indexes (WI) 

• NDWI (Normalized Difference Water Index) 
o Formula: (B3 - B8) / (B3 + B8) 
o Required bands: B3 (Green) & B8 (NIR) 

• MNDWI (Modified Normalized Difference Water Index) 
o Formula: (B3 - B11) / (B3 + B11) 
o Required bands: B3 (Green) & B11 (SWIR1) 

Snow Indexes (SI) 

• NDSI (Normalized Difference Snow Index) 
o Formula: (B3 - B11) / (B3 + B11) 
o Required bands: B3 (Green) & B11 (SWIR1) 

• NDSII (Normalized Difference Snow Ice Index) 
o Formula: (B3 - B12) / (B3 + B12) 
o Required bands: B3 (Green) & B12 (SWIR2) 

Correct Sentinel-2 Data 

• The Sentinel Hub EO Browser should be accessed. 
• The Sentinel-2 L2A (BOA Reflectance) dataset should be selected. 
• The following bands should be chosen:  

o B2 (Blue) 
o B3 (Green) 
o B4 (Red) 
o B8 (NIR) 
o B11 (SWIR1) 
o B12 (SWIR2) 

• The "GeoTIFF (Analytical)" format should be selected. 
• The CRS should be set to EPSG:4326. 
• The data should then be downloaded and processed in QGIS. 
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Popular Remote Sensing Indices for Sentinel-2 

1. NDVI (Normalized Difference Vegetation Index): 
o Bands: B08 (NIR) and B04 (Red) 
o Formula: (B08 - B04) / (B08 + B04) 
o Application: Assessing vegetation health and density. 

2. EVI (Enhanced Vegetation Index): 
o Bands: B08 (NIR), B04 (Red), and B02 (Blue) 
o Formula: 2.5 * (B08 - B04) / (B08 + 6B04 - 7.5B02 + 1) 
o Application: Improved sensitivity in areas of dense vegetation. 

3. NDWI (Normalized Difference Water Index): 
o Bands: B03 (Green) and B08 (NIR) 
o Formula: (B03 - B08) / (B03 + B08) 
o Application: Monitoring water content in vegetation and water 

bodies. 
4. NDMI (Normalized Difference Moisture Index): 

o Bands: B08 (NIR) and B11 (SWIR) 
o Formula: (B08 - B11) / (B08 + B11) 
o Application: Detecting moisture content in soil and vegetation. 

5. SAVI (Soil Adjusted Vegetation Index): 
o Bands: B08 (NIR) and B04 (Red) 
o Formula: ((B08 - B04) / (B08 + B04 + L)) * (1 + L), where L is a 

soil brightness correction factor (typically 0.5) 
o Application: Reducing soil brightness influence in vegetation index 

calculations. 
6. GNDVI (Green Normalized Difference Vegetation Index): 

o Bands: B08 (NIR) and B03 (Green) 
o Formula: (B08 - B03) / (B08 + B03) 
o Application: Monitoring chlorophyll content in vegetation. 

7. NDSI (Normalized Difference Snow Index): 
o Bands: B03 (Green) and B11 (SWIR) 
o Formula: (B03 - B11) / (B03 + B11) 
o Application: Identifying snow-covered areas. 
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Useful Band Combinations 

1. True Color: 
o Bands Used: B4 (Red), B3 (Green), B2 (Blue) 
o Purpose: Produces a natural-looking image similar to what the 

human eye would see. 
2. False Color Infrared: 

o Bands Used: B8 (NIR), B4 (Red), B3 (Green) 
o Purpose: Highlights vegetation (appears red), which is useful for 

monitoring plant health and density (Hatari Labs). 
3. Shortwave Infrared (SWIR): 

o Bands Used: B12 (SWIR), B8A (NIR), B4 (Red) 
o Purpose: Differentiates between soil and vegetation, and monitors 

moisture content (GIS Geography). 
4. Agriculture: 

o Bands Used: B11 (SWIR-1), B8 (NIR), B2 (Blue) 
o Purpose: Monitors crop health and identifies vegetation types 

(Hatari Labs). 

 

 

 

 

 

Table 8: Indexes that use for Landsat 8 and Sentinel 2 

 
 

 

https://hatarilabs.com/ih-en/working-with-sentinel-2-imagery-on-qgis
https://gisgeography.com/sentinel-2-bands-combinations/
https://hatarilabs.com/ih-en/working-with-sentinel-2-imagery-on-qgis
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Vegetation 

1-Normalized Difference Vegetation Index (NDVI) 

Sentinel-2 bands: (B8 - B4) / (B8 + B4) 

2-Red-Edge NDVI (NDVIre) 

Sentinel-2 bands: (B8 - B5) / (B8 + B5) 

The specific bands corresponding to NIR (Near Infrared) and Red vary depending 
on the satellite and sensor used for the imagery in Sentinel-2 satellite: 

Sentinel-2 

• Red: Band 4 (665 nm) 
• NIR: Band 8 (842 nm) 

Two of the best indices for vegetation analysis in QGIS are the Normalized 
Difference Vegetation Index (NDVI) and the Enhanced Vegetation Index (EVI).  
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1. Normalized Difference Vegetation Index 
(NDVI) 
NDVI is a commonly used vegetation index that indicates the presence and 
condition of vegetation by measuring the difference between near-infrared (NIR) 
and red light reflected by vegetation. 

Select and load the necessary band files. For example, for Sentinel-2, Band 4 
(Red) and Band 8 (NIR) would be loaded. 

 

Calculation: 

 

Steps to Calculate NDVI in QGIS: 

1. Load Satellite Imagery: 
o Load the raster layer containing the necessary bands (NIR and Red) 

into QGIS. 
2. Open the Raster Calculator: 

o Go to Raster > Raster Calculator. 
3. Enter the NDVI Formula: 

o In the Raster Calculator expression field, input the NDVI formula. 
Assuming Band 4 is Red and Band 5 is NIR, the expression will look 
like: 

Code 

("Band5" - "Band4") / ("Band5" + "Band4") 

4. Specify Output: 
o Set the output layer and location. 
o Click OK to generate the NDVI layer. 
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2.Enhanced Vegetation Index (EVI) 
EVI improves upon NDVI by reducing the effects of atmospheric conditions and 
canopy background signals. It includes the Blue band in addition to Red and NIR 
bands. 

Calculation: 

 

Steps to Calculate EVI in QGIS: 

1. Load Satellite Imagery: 
o Load the raster layer containing the necessary bands (NIR, Red, and 

Blue) into QGIS. 
2. Open the Raster Calculator: 

o Go to Raster > Raster Calculator. 
3. Enter the EVI Formula: 

o In the Raster Calculator expression field, input the EVI formula. 
Assuming Band 4 is Red, Band 5 is NIR, and Band 2 is Blue, the 
expression will look like: 

Code 

2.5 * (("Band5" - "Band4") / ("Band5" + 6 * "Band4" - 7.5 * "Band2" + 1)) 
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SNOW 
 

In QGIS, there are several indexes that can be used for snow cover analysis, but 
two of the most commonly used ones are the Normalized Difference Snow Index 
(NDSI) and the Snow Cover Index (SCI): 

1. Normalized Difference Snow Index (NDSI) 
Formula:  

 

Description: NDSI is a widely used snow index that utilizes the reflectance 
properties of snow in the green and shortwave infrared (SWIR) bands. Snow 
typically has high reflectance in the visible green band and low reflectance in the 
SWIR band, making this index effective for differentiating snow from other land 
cover types. 

Sentinel-2 Bands: 

• NDSI: 
o Green: Band 3 
o SWIR: Band 11 

• SCI: 
o NIR: Band 8 
o Red: Band 4 

Steps to Calculate NDSI in QGIS: 

1. Load the satellite image (such as Landsat or Sentinel-2) into QGIS. 
2. Open the Raster Calculator (Raster > Raster Calculator). 
3. Enter the NDSI formula using the appropriate bands for Green and SWIR. 

For Landsat 8, use Band 3 for Green and Band 6 for SWIR1. 
4. Click OK to generate the NDSI raster. 
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2. Snow Cover Index (SCI) 
Formula:  

CHOOSE nother  

Description: SCI, similar to NDSI, leverages the spectral properties of snow, 
particularly in the near-infrared (NIR) and red bands. Snow generally reflects 
strongly in the visible spectrum but less so in the NIR, which helps in 
distinguishing snow cover. 

Steps to Calculate SCI in QGIS: 

1. Load the satellite image into QGIS. 
2. Open the Raster Calculator (Raster > Raster Calculator). 
3. Enter the SCI formula using the appropriate bands for NIR and Red. For 

Landsat 8, use Band 5 for NIR and Band 4 for Red. 
4. Click OK to generate the SCI raster. 

Accurate Snow Cover Analysis 

• Cloud Masking: Clouds should be masked out, as they can be mistaken 
for snow. 

• Thresholding: Threshold values should be applied to the indexes to ensure 
accurate classification of snow-covered areas. 

• Temporal Analysis: Time series data should be used to monitor changes 
in snow cover over time. 

Satellite imagery from Landsat 8 and Sentinel-2 is widely used in ArcGIS Pro 
for various remote sensing and geospatial analysis tasks. These datasets are 
imported into the software and are processed using tools that are built into the 
Image Analyst and Spatial Analyst extensions. 

Land cover classifications are performed using supervised or unsupervised 
classification methods, and spectral indices such as NDVI (Normalized 
Difference Vegetation Index) are calculated to assess vegetation health. Image 
composites and band combinations are also generated to enhance visual 
interpretation. Georeferencing and atmospheric corrections are typically applied 
before analysis, and results are visualized and interpreted using custom 
symbology. Throughout the workflow, data accuracy and metadata are 
maintained, and final outputs are exported or shared through ArcGIS Online or 
other platforms. 
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Water 

 
For calculating water bodies using Sentinel-2 images in QGIS, two of the best 
indexes are the Normalized Difference Water Index (NDWI) and the Modified 
Normalized Difference Water Index (MNDWI): 

1. Normalized Difference Water Index (NDWI) 
Formula:  

 

Required Bands: 

• Green Band: Band 3 
• Near-Infrared (NIR) Band: Band 8 

Bands required for Sentinel-2 indexes: 

NDWI: 

• Green: Band 3 
• NIR: Band 8 

MNDWI: 

• Green: Band 3 
• SWIR: Band 11 

 

Description: NDWI is used to delineate open water features and enhance their 
presence in remotely sensed digital imagery. It exploits the absorption properties 
of water in the near-infrared (NIR) and the high reflectance in the green 
wavelengths. 
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2. Modified Normalized Difference Water Index 
(MNDWI) 
Formula:  

 

Required Bands: 

• Green Band: Band 3 
• Shortwave Infrared (SWIR) Band: Band 11 

Description: MNDWI is an enhancement of NDWI, designed to improve the 
accuracy of water body detection, especially in urban areas. It uses the SWIR 
band instead of the NIR band, which helps to reduce the noise from built-up land 
and vegetation, thereby providing a clearer distinction of water bodies. 

Steps to Calculate NDWI and MNDWI in QGIS: 

1. Load the Satellite Image: 
o Open QGIS and load the Sentinel-2 image. 

2. Open the Raster Calculator: 
o Go to Raster > Raster Calculator. 

3. Enter the Formula: 
o For NDWI: 

plaintext 

Copy code 

( "Band 3" - "Band 8" ) / ( "Band 3" + "Band 8" ) 

o For MNDWI: 

plaintext 

Copy code 

( "Band 3" - "Band 11" ) / ( "Band 3" + "Band 11" ) 

4. Generate the Index Raster: 
o Click OK to generate the NDWI or MNDWI raster. 



61 
 

8. Results and Discussion 
After the classification process, a land cover map was generated from the 
processed sentinel -2 and the landsat 8 imagery. Specific land cover classes were 
successfully identified, and their spatial distribution was clearly depicted. 
Vegetation, manufactured areas, water bodies and bare lands were among the 
primary categories that were mapped. The classification output had visually 
evaluated, and spatial consistency was observed in most areas of the study field. 

The accuracy evaluation was done using reference points and an illusion matrix, 
and the classification performance through statistical matrix was evaluated. An 
overall accuracy was achieved over the acceptable threshold, and the Cuppa 
coefficient indicated a strong agreement between classified results and reference 
data. However, some miscarriage was mentioned, especially in areas where the 
spectral signatures of various land cover types were overlaps. These issues were 
usually seen in transitional regions such as urban -agricultural borders or wetlands 
-correction interfaces. 

The results were explained in relation to the known land use pattern and 
environmental characteristics. Urban expansion, vegetative density and water 
distribution patterns were clearly revealed. Areas of high vegetation were 
concentrated in northern and western regions, while urban growth was mainly 
seen in southern regions. These spatial trends were supported by supporting data 
and field knowledge, and their implications were considered in terms of land 
management and planning. 

When compared to Sentinel -2 and Landsat 8 results, a slight difference was 
detected due to their separate spatial proposals and spectral characteristics. The 
Sentinel -2 data provided fine expansion in urban and agricultural areas, while 
Landsat 8 allowed for extensive regional evaluation. However, both datasets were 
found to be suitable for land cover classification, when appropriate preprocessing 
steps were applied. 

The boundaries of the functioning were also accepted. The classification accuracy 
was influenced by cloud cover, seasonal effects and training data quality. 
Additionally, the use of the image of solo prohibited the analysis of cosmic 
dynamics. Despite these obstacles, valuable information was extracted, and the 
classification results provided a reliable basis for further spatial analysis and 
decision making. 
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To monitor the impact of climate change on mountain water resources, the 
major conclusions from the Analysis of Sentinel -2 and Landsat Landkavar 
satellite imagery, especially focus on ice covering and vegetation dynamics in 
small maritime. Results are discussed regarding historical trends, climate 
change and potential ecological implications. 

 

2. Changes in snow cover in small maritime 

2.1 The limit of ice cover and decline in duration 

The generalized difference from the Sentinel-2 and Landsat images reflects a 
progressive decline between analysis of Snow Index (NDSI) (such as, eg, 2000–
2024) and a progressive decline in snow-covered areas on mid-height. 

• The period of annual ice cover during the study period has decreased by x%, a 
trend towards the earlier snowmelt in the spring and the later snowfall in 
autumn. 

• The spatial range of permanent ice cover is reduced, especially at the bottom 
height (specific height range, e.g., 2,500 m). 

 

2.2 Shift in height of snow line 

• The snow line has increased by about several meters per decade, which has 
confirmed the effect of rising temperature. 

• The firmness of snow has declined at low altitude, indicating an increase in 
winter rains rather than snowfall. 

The discovery aligns with regional climatic estimates that predict seasonal ice 
storage and cuts, which will possibly affect the availability of Downstream 
water for ecosystem and human use. 
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2.3 Correlation with temperature and rainfall trends 

• The statistical correlation between temperature data from the limit of Era5 and 
ice cover confirms that the increasing winter temperature contributes significantly 
to reduce the accumulation of ice. 

• Rain trends indicate a change from snowfall to rain at a lower height, which 
accelerates snowmelt processes. 

These findings highlight the vulnerability of the seasonal water storage system of 
Alpi Marittime and emphasize the need for adaptive water resources 
management. 

 

3. Botanical reaction to climate change 

3.1 Increasing vegetation green in Alpine regions 

Satellite-type NDVI (generalized differential vegetation index) and EVI 
(extended botanical index) indicate a significant increase in botanical 
productivity in high altitude. 

In the last two decades, NDVI values have increased, which reflects long growing 
weather and high plant biomass. 

The most pronounced greening is seen above 1,800 meters, where earlier snow -
capped areas are now supporting vegetation growth. 

 

3.2 Extension of Alpine vegetation in high height 

The vegetation has migrated above average to average average of x meter, 
indicating a reaction to heating the temperature and reducing the period of ice. 

This change suggests that climate-inspired vegetation expansion is changing the 
alpine ecosystem structure, leading to potential competition between indigenous 
alpine species and newly established plants communities. 

 

3.3 Botanical health declines in some areas 

While most areas show trends of greenery, some regions demonstrate a decline 
in NDVI, which shows stress of potential ecosystems. 

Dryer South slope shows symptoms of decline in vegetation, which is caused by 
an increase in drought conditions in summer. 
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The loss of moisture-dependent alpine plants could lead to biodiversity shifts 
and increased soil erosion risks. 

These contrasting trends highlight the complexity of climate change impacts on 
vegetation, with some areas benefiting from extended growing seasons while 
others experience stress due to rising temperatures and reduced moisture 
availability. 

 

4. Land Cover Changes and Their Implications 

4.1 Changes in Land Cover Composition 

Analysis of Landsat Landcover classification maps reveals a transition in 
landscape types over the past two decades: 

 

These land cover changes confirm the climate-driven transformation of 
mountain landscapes, with snow retreating, forests expanding, and rock 
exposure increasing due to glacier melt. 

 

 

 

4.2 Impact on Water Availability 

• Earlier snowmelt and reduced seasonal snow storage impact river 
flows, increasing the risk of summer water shortages for downstream 
communities and ecosystems. 

• Vegetation expansion at higher elevations may lead to increased 
evapotranspiration, further affecting the regional water balance. 

These findings highlight the need for adaptive water management strategies 
to address changing hydrological regimes in the Alpi Marittime 

5. Discussion: Implications and Future Perspectives 

5.1 Climate Change and Mountain Hydrology 

The observed decline in snow cover and changes in vegetation dynamics 
align with global trends in alpine environments affected by climate change. 
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• If current warming trends continue, the Alpi Marittime will experience 
further reductions in seasonal snow storage, increasing reliance on 
rainfall-driven water sources. 

• Vegetation shifts will alter local ecosystems and biodiversity, with 
some species benefiting and others facing habitat loss. 

 

5.2 Challenges in Long-Term Monitoring 

• Cloud cover and seasonal variability in satellite imagery remain a 
challenge for consistent monitoring. 

• Field validation is required to improve the accuracy of remote sensing 
classifications, particularly in heterogeneous mountain terrain. 

 

5.3 Recommendations for Future Research 

• Multi-sensor approaches: Combining Sentinel-1 SAR (for snow 
depth) and Sentinel-2 optical imagery can improve snow monitoring 
accuracy. 

• Integration of ground-based data: Installing automatic snow and 
vegetation monitoring stations could enhance model validation. 

• Hydrological modeling: Using satellite-derived climate and land cover 
data to develop predictive models for future water availability 
scenarios. 
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8.Conclusion 
In this study, the Sentinel -2 and Landsat 8 satellite imagery were successfully 
processed, classified and analyzed using the ArcGIS Pro. High quality imagery 
was acquired from the EO browser, and the required preprocessing stages such as 
band stacking, clipping and launch alignment were performed. A supervised 
classification approach was employed, and accurate land cover maps were 
generated through the application of the machine learning algorithms. 

Training samples were created and used to develop classification models, which 
were then applied to overall images. The resulting land cover output was refined 
through post-classification filtering and, when necessary, preratification. The 
accuracy assessment was held, and the classification levels confirmed by the 
statistical assessment matrix were obtained acceptable levels of accuracy. 

Through the integration of classified data classified with additional spatial layers, 
valuable insight and environmental characteristics were obtained in the land use 
pattern. Spacious variations were identified, and trends in vegetation, 
urbanization and water distribution were clearly depicted. The utility of both 
Sentinel -2 and Landsat 8 data was confirmed for land cover analysis, offering 
unique benefits based on the scale of resolution and application with each dataset. 

Cloud covers, despite the minor limitations due to spectral confusion and 
resolution differences, reliable results were produced. Workflow was followed, 
which demonstrated the effectiveness of the ArcGIS Pro as a platform for remote 
sensing analysis. It has been concluded that, with proper preprocessing and 
verification, satellite imagery can be used effectively for land cover classification 
and spatial analysis in support of environmental monitoring and planning efforts. 

 

The purpose of this study is to provide a quantitative and spatial clear evaluation 
of how climate change is changing ice and vegetative patterns in the Alpi 
Marittime. By using the Sentinel -2 and Landsat landcover data, it attempts to 
bridge the difference between climate science and environmental policy, which 
provides scientifically strong insight to permanent water and ecosystem 
management. Despite the underlying boundaries of satellite remote sensing, this 
research mountain will contribute to a deeper understanding of climate-inspired 
changes in hydrology and biodiversity. 
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Monitoring of ice cover and vegetation dynamics in the mountain environment 
is important to understand the effects of climate change on water resources. 
Satellite remote sensing, especially using Sentinel -2 and Landsat landcover 
data, offers a strong and scalable approach to analyze these changes over time. 
By combining multi-temporal remote sensing analysis with land cover 
classification, this research will contribute to improving climate adaptation 
strategies and sustainable resource management in Alpi Marittime. 

 

This study confirms that climate change is fundamentally changing water 
resources availability in the dynamics, vegetation distribution and ALPI 
Marittime. 

• Decline in ice cover and transfer of vegetative patterns exposes the sensitivity 
of the mountain ecosystem for climate change. 

• Satellite imagery from Sentinel -2 and Landsat Landcover has proved effective 
in tracking these changes over time, providing valuable insight to climate 
adaptation and conservation schemes. 

• Future research should focus on improving the integration of remote sensing, 
field data and climate modelling to increase long -term monitoring efforts. 
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10.Attachments  
Attachment 1: Study area map 

• A high-resolution map of Alpi Marittime, which reflects height, land cover type 
and major observation points. 

• Source: GIS analysis from Sentinel -2 and landsat data. 

 

Attachment 2: Time-series analysis diagram 

• Graph 1: Snow cover area changes from 2000-2024. 

• graph 2: NDVI trends showing vegetation greenery at high altitude. 

• Graph 3: Temperature and rainfall trends in the study period. 

 

Attachment 3: Sample Satellite Image Processing Workflow 

1. Data Acquisition: Usgs Earth Explorer/Download Sentinel -2/Landsat images 
from the Copernicus Open Hub. 

2. Preprocessing: atmospheric improvement, cloud masking, and radiometric 
adjustment. 

3. Index Count: Count NDSI, NDVI using Google Earth Engine/QGIS. 

4. Detection of change: Compare multi-temporal images to detect ice/vegetative 
shifts. 

5. Verification: Cross-check results with field data or external dataset. 

 

Attachment 4: Field Verification Report  

• Details of field visits, location and ground trousers data collection. 

• Comparison of satellite ice/vegetative data with area observations. 

 

Attachment 5: Additional References and Resources 

• Code snipped for satellite image processing (e.g., python, Google Earth Engine). 

• Links of online climate dataset for further research 


